Lighten the administrative load with Dell Client Command Suite

The tool enabled faster and less complicated device management on a Dell OptiPlex 7050 Micro Desktop with Intel AMT technology

Your IT administrators are responsible for what often seems like a never-ending log of tasks. These tasks range from the simple—like helping an employee change their password—to the more complex, like updating software for different user groups.

Wouldn’t it be better if all their tasks were simple? The more work your administrators can complete in a day, the better your business flows. Tools such as Intel® Active Management Technology (AMT), which is part of the set of Intel vPro™ technologies, can improve management capabilities, but learning the software can be a time-consuming challenge. With integrations for Intel AMT and an easy-to-use GUI, Dell Client Command Suite can lessen the administrative burden and help your admins finish more tasks each day.

At Principled Technologies, we compared common device management tasks on two sets of Dell OptiPlex 7050 Micro Desktop computers. Though we managed both sets in a Microsoft environment, one set used the Dell Client Command Suite, while the other set did not. We found that the devices with Dell Client Command Suite were easier to manage than those without. Faster, simpler device management can help your admins close out support tickets more quickly, resolving issues that could otherwise slow down the speed of your business.
The technologies we used

Computers with Intel Core™ vPro™ processors come with Intel Active Management Technology (Intel AMT), a set of tools built into the system’s motherboard that enhance management capabilities. Intel AMT, however, is a complex piece of software. Dell Client Command Suite is a host of integrations that simplify and build upon the strong foundation of Intel AMT to deliver a streamlined management experience.

In our tests, we compared management in three scenarios: Using Dell Client Command Suite to remotely manage Dell desktop devices; using only Intel AMT to remotely manage the desktops; and directly managing the desktops without Dell Client Command Suite or Intel AMT. In each of our tests, it was faster for an administrator to complete management tasks through Dell Client Command Suite rather than completing tasks with Intel AMT alone, or through direct, manual management. The diagram below shows our test scenarios:

![Diagram showing management scenarios](image)

---

**Figure 1: Logical diagram of Dell Client Command Suite management**

---

Dell Client Command Suite tools make things easier for admins

Dell Client Command Suite has a ton of features admins can use to manage employee devices with less hassle:

- Task sequences to configure or disable AMT on the target client.
- Reports with information on:
  - Out-of-band manageability (BIOS versions, firmware versions, and other information from AMT)
  - Provisioning information (date, time, certificate info)
  - Battery health for laptop devices
  - Hardware inventory reports: the model names of your entire fleet, as well as information on processors, RAM, storage, networks, and IP addresses
- Ability to monitor the state of any device in your fleet
An admin’s story: Saving time with Dell Client Command Suite

Eva’s workplace recently started using Dell Client Command Suite to improve how the company manages their employee devices. Even though Eva is new to using Intel AMT, the Dell integrations make it easy for her to jump right in.

First on Eva’s task list: Configuring the employee devices to enable the features that come with Intel AMT. Thanks to the intuitive GUI in Dell Client Command Suite, this poses little trouble. If she had to work with Intel AMT directly, Eva would have to spend hours, days, even weeks working with her IT department to configure certificates, Microsoft Active Directory, AMT profiles, and more—all just to get the solution up and running. With the help of Dell Client Command Suite, that setup time shrinks to a few minutes.

With Command Suite, it takes Eva 48 seconds to configure Intel AMT on a single device, compared to 51 seconds without Dell Client Command Suite (ignoring research time). Thanks to the one-to-many capabilities that come with Command Suite, Eva takes just 48 seconds no matter how many devices she needs to configure. Whether it’s five, ten, or a hundred devices, the steps are identical. Without Dell Client Command Suite, the amount of hands-on time grows with each additional device.

It’s the same story whether Eva’s configuring BIOS settings or changing security settings for the company’s fleet: she saves time by interfacing with Dell Client Command Suite as opposed to approaching the job manually.

<table>
<thead>
<tr>
<th>Task (1 system)</th>
<th>Dell Client Command Suite</th>
<th>Intel AMT only</th>
<th>Manual admin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provisioning Intel AMT</td>
<td>48s</td>
<td>N/A</td>
<td>51s</td>
</tr>
<tr>
<td>Changing 10 BIOS settings</td>
<td>1min 35s</td>
<td>1min 45s</td>
<td>1min 48s</td>
</tr>
<tr>
<td>Changing security settings</td>
<td>28s</td>
<td>45s</td>
<td>42s</td>
</tr>
</tbody>
</table>

Table 1: Time to manage one Dell OptiPlex system (tested)

<table>
<thead>
<tr>
<th>Task (100 systems)</th>
<th>Dell Client Command Suite</th>
<th>Intel AMT only</th>
<th>Manual admin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provisioning Intel AMT</td>
<td>48s</td>
<td>N/A</td>
<td>1h 26min 39s</td>
</tr>
<tr>
<td>Changing 10 BIOS settings</td>
<td>1min 35s</td>
<td>2h 46min 45s</td>
<td>2h 53min 24s</td>
</tr>
<tr>
<td>Changing security settings</td>
<td>28s</td>
<td>1h 11min 42s</td>
<td>1h 10min 00s</td>
</tr>
</tbody>
</table>

Table 2: Time to manage 100 Dell OptiPlex systems (estimated)

Extrapolating to 100 systems reveals an even starker contrast. With Dell Client Command Suite, you can finish a management task for all your target devices in one sitting. Without the tool, you’d have to configure the devices one at a time. Table 2 shows our extrapolated figures.

Managing an employee fleet with Dell Client Command Suite is also much simpler than managing manually or via Intel AMT alone. For example, changing the admin password for 100 devices took seven steps with the Dell suite, 400 steps manually, and 601 steps when using only Intel AMT. For a detailed steps breakdown for the tasks we tested, see the results appendix on page 19.
How Dell Client Command Suite saves valuable admin time

How does Dell Client Command Suite save so much time? A variety of factors add up to make management with Dell Client Command Suite less time-intensive than managing through Intel AMT alone.

Ease of setup

Dell Client Command Suite uses a clean GUI to walk you through Intel AMT configuration, using information you provide to set up the solution for you. Without Dell Client Command Suite, setting up Intel AMT can take many hours of research, trial, and error if you aren’t already an expert.

One-to-many administration

Traditionally, managing employee devices requires working with each device individually. This adds up to a lot of time wasted for management tasks that need to be applied en masse.

Dell Client Command Suite saves administrators time by only requiring single entry of a command before pushing said command out to any number of employee devices. Through the intuitive GUI, an admin simply specifies her desired changes and selects the target systems—that’s the end of their involvement. Dell Client Command Suite then goes to work, sending the command to each targeted system and freeing the admin to take care of whatever’s next for the day.

Thanks to this one-to-many capability, Eva takes the same amount of time no matter how many devices she configures. Whether it’s five, ten, or a hundred devices, Eva’s time commitment is the same—minimal and streamlined. Without Dell Client Command Suite, the amount of hands-on time grows proportionally with each additional device.

Out-of-band administration

A feature of Intel AMT, out-of-band management means administrators can push updates to employee devices regardless of whether they’re turned off or disconnected from your office network. Combined with one-to-many administration, this means Eva can push updates to hundreds of machines and not have to worry about whether someone’s computer is offline or out of power.

Task sequences

In Dell Client Command Suite, task sequences are automated scripts that run locally on the target client. Dell Client Command Suite comes with a task sequence that configures Intel AMT on target systems. Without the task sequence, Eva would have to manually configure each device, taking up hours of her time.

All these features add up to a more manageable management solution for admins. By the end of the day, Eva is glad her company chose to invest in the technology.

Manage devices from anywhere with Intel AMT

Management with AMT can take place from any of your offices, no matter how remote. As long as the target device is connected to the corporate network, you can manage it just as you would your local fleet.
Conclusion

Managing a fleet of employee devices can be a challenging and time-consuming affair for your administrators to handle. But with the right tools, admins could finish their management tasks faster and dedicate their valuable time to other mission-critical work.

At Principled Technologies, we investigated how using Dell Client Command Suite could affect the device management process. We found that the tools afforded by Dell Client Command Suite allow for faster and simpler device management compared to completing tasks manually. The ease of configuring Intel AMT combined with task sequences, out-of-band management capabilities, one-to-many administration, and other features make Dell Client Command Suite an attractive management solution for fleets with Intel vPro technology.
On January 17, 2018, we finalized the hardware and software configurations we tested. Updates for current and recently released hardware and software appear often, so unavoidably these configurations may not represent the latest versions available when this report appears. For older systems, we chose configurations representative of typical purchases of those systems. We concluded hands-on testing on February 1, 2018.

Appendix A: System configuration information

<table>
<thead>
<tr>
<th>System</th>
<th>Dell OptiPlex 7050 Micro Desktop</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>Intel®</td>
</tr>
<tr>
<td>Name</td>
<td>Core™ i5</td>
</tr>
<tr>
<td>Model number</td>
<td>7500T</td>
</tr>
<tr>
<td>Core frequency (GHz)</td>
<td>2.7 – 3.3</td>
</tr>
<tr>
<td>Number of cores</td>
<td>4</td>
</tr>
<tr>
<td>Cache</td>
<td>6 MB L3</td>
</tr>
<tr>
<td>Memory</td>
<td></td>
</tr>
<tr>
<td>Amount</td>
<td>8 GB</td>
</tr>
<tr>
<td>Type</td>
<td>DDR4</td>
</tr>
<tr>
<td>Speed</td>
<td>2,400 MHz</td>
</tr>
<tr>
<td>Graphics</td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>Intel</td>
</tr>
<tr>
<td>Model number</td>
<td>HD Graphics 630</td>
</tr>
<tr>
<td>Storage</td>
<td></td>
</tr>
<tr>
<td>Amount</td>
<td>1 TB</td>
</tr>
<tr>
<td>Type</td>
<td>7,200 RPM</td>
</tr>
<tr>
<td>Connectivity/expansion</td>
<td></td>
</tr>
<tr>
<td>Wired internet</td>
<td>Intel I219-LM</td>
</tr>
<tr>
<td>USB</td>
<td>1 x USB 3.1 Gen 1 Type-C Port</td>
</tr>
<tr>
<td></td>
<td>5 x USB 3.1 Gen 1 Port</td>
</tr>
<tr>
<td>Video</td>
<td>1 x DisplayPort 1.2</td>
</tr>
<tr>
<td></td>
<td>1 x HDMI</td>
</tr>
<tr>
<td>Display</td>
<td></td>
</tr>
<tr>
<td>Size (in.)</td>
<td>22</td>
</tr>
<tr>
<td>Type</td>
<td>LED Backlit</td>
</tr>
<tr>
<td>Resolution</td>
<td>1,920 x 1,080</td>
</tr>
<tr>
<td>Touchscreen</td>
<td>No</td>
</tr>
<tr>
<td>System</td>
<td>Dell OptiPlex 7050 Micro Desktop</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Operating system</td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>Microsoft</td>
</tr>
<tr>
<td>Name</td>
<td>Windows 10 Pro</td>
</tr>
<tr>
<td>Build number or version</td>
<td>Build 16299 (1709)</td>
</tr>
<tr>
<td>BIOS</td>
<td></td>
</tr>
<tr>
<td>BIOS name and version</td>
<td>Dell 1.6.5</td>
</tr>
</tbody>
</table>
Appendix B: How we tested

Testing Setup

Setting up the Microsoft SCCM environment

Configuring Windows Server 2016
After installing Windows Server on our golden VM and installing all updates up to 01/19/2018, we configured Windows by making the following changes. We then cloned the VM to a template to use for all VMs.

Configuring Windows Update
1. In the left pane of the Server Manager window, click Local Server.
2. In the main frame, next to Windows Update, click Not configured.
3. In the Windows Update window, in the main pane, click Let me choose my settings.
4. Under Important updates, select Never check for updates (not recommended), and then click OK.
5. In the left pane, click Check for updates, and install all available updates.

Configuring Windows Firewall
1. In Server Manager, click Tools → Windows Firewall with Advanced Security.
2. In the Overview section, click Windows Firewall Properties.
3. In the Domain Profile tab, for Firewall state, click Off.
4. In the Private Profile tab, for Firewall state, click Off.
5. In the Public Profile tab, for Firewall state, click Off.
6. Click OK.
7. Close the Windows Firewall Properties window.

Setting up Remote Desktop
1. In the Local Server tab of the Server Manager window, next to Remote Desktop, click Disabled.
2. In the System Properties window that appears, in the Remote Desktop section, select the Allow remote connections to this computer radio button, and click OK when the warning message appears.
3. Uncheck Allow connections only from computers running Remote Desktop with Network Level Authentication (recommended) and click OK.

Disabling IE Enhanced Security Configuration
1. In the Local Server tab of the Server Manager window, next to IE Enhanced Security Configuration, click On.
2. In the Internet Explorer Enhanced Security Configuration window, select the Off radio buttons for both Administrators and Users, and click OK.

Installing and configuring the infrastructure server
We cloned our Windows Server 2016 DC VM to create an Active Directory VM, a Certificate Authority VM, and a System Center Configuration Manager VM.

Configuring AD/DNS/DHCP
1. Power on the Active Directory VM.
2. On the Active Directory server, open Windows PowerShell® as administrator.
3. Run the following command: Install-WindowsFeature RSAT-ADDS
4. When the installation is finished, close PowerShell.
5. Open Server Manager.
6. On the Welcome screen, click 2, and click Add roles and features.
7. At the initial Before you begin screen, click Next three times.
8. At the Server Roles screen, select Active Directory Domain Services.
9. On the pop-up window, click Add Features.
10. Click Next three times.
11. Verify the desired role is being installed, and click Install.
12. Once installation has finished, close the Add roles and features wizard.
13. In Server Manager, click the flag at the top, and select the Promote this server to a domain controller link.
14. Select Add a new forest, enter a root domain name of test.local, and click Next.
15. On the Domain Controller Options screen, enter a password, and click Next.
16. On the DNS Options screen, click Next.
17. On the Additional Options screen, click Next.
18. On the Paths screen, click Next.
20. On the Prerequisites screen, verify all prerequisites have passed, and click Install.
21. Once Active Directory Domain Services finishes installing, click Finish, and restart the system.

Adding DHCP
1. Open Server Manager.
2. On the Welcome screen, click 2, and click Add roles and features.
3. At the initial Before you begin screen, click Next three times.
4. At the Server Roles screen, select DHCP Server.
5. On the pop-up window, click Add Features.
6. Click Next three times.
7. Verify the desired role is being installed, and click Install.
8. Once installation has finished, close the Add roles and features wizard.
9. In Server Manager, click the flag at the top of the screen and select Complete DHCP configuration.
10. In the DHCP Post-Install configuration wizard window, click Next.
11. At the Authorization Screen, click Commit.
12. At the Summary screen, click Close.
13. In Administrative Tools, open the DHCP service.
14. Expand ad.test.local, then right click IPv4 and select New Scope
15. In the New Scope Wizard window, click Next.
16. At the scope name screen, name the scope Laptops, and click Next.
17. In the IP Address Range, enter the desired scope settings for your network.
18. Click Next four times.
19. At the Router screen, enter the gateway address to be used by the clients, and click Next.
20. Click Next three times.
21. At the Completing the New Scope Wizard screen, click Finish.

Creating Containers and Extending the AD Schema
2. On the toolbar, select Action→Connect to…
3. Accept the defaults by clicking OK.
4. Under Default Naming Context→DC- test, DC=local, right-click CN = System, and select New→Object…
5. Select Container, and click Next.
6. Under Value, enter System Management. Click Next, and click Finish.
8. On the toolbar, select View, and click Advanced Features.
10. Click Next.
11. Click Add.
12. Click Object Types and select Computers, then click OK.
13. Enter CM, the computer account for the configuration server, as an object name and click OK.
14. Click Next.
15. Select Create a custom task to delegate, and click Next.
16. Choose This folder, existing objects… and click Next.
17. Click Full Control, and click Next.
18. Click Finish.
19. Attach the SCCM installation media to the VM.
20. From the installation media, navigate to \SMSSETUP\BIN\X64. Right-click extadsch, and run as administrator.
21. Review extadsch.log at the root of the system drive to confirm the operation was successful.
Creating Active Directory accounts for System Center Configuration Manager

1. On the Domain Controller, open Active Directory Administrative Center
2. Under test (local), in the Tasks panel, click New, and select Group from the drop-down menu.
3. In the Create Group window, use the following options:
   - **Group name:** Kerberos Admins
   - **Group type:** Security
   - **Group scope:** Global
4. Add Kerberos Admins as a member of the Domain Admins group.
5. Add the computer account of the SCCM server to the Kerberos Admins security group and click OK.
6. Create an Organizational Unit for AMT managed systems called AMT Managed.
7. Create a security group called AMT Control.

Configuring the environment

Configuring Post Active Directory Deployment

1. On the Certificate Authority and Configuration Manager servers, change the name of the server. For Certificate Authority, name it CA. For the Configuration Manager server, name it CM.
2. Set a static IP address for each server.
3. Join each server to the domain using the Join domain option.

Adding the configuration manager server as a trusted server

1. On the Certificate Authority and Configuration Manager servers, run `lusrmgr.msc`
2. Select Groups.
3. Right-click Administrators, and click Properties.
4. Click Add.
5. Select Object Types, check the box for Computers, and click OK.
6. Add the computer name for the management server.

Installing SQL 2016

1. Log into the Configuration Manager server as domain\administrator.
2. Attach the installation media for SQL 2016, and run the setup.exe file.
3. In the SQL Server Installation Window, select Installation from the menu on the left, and select New SQL Server stand-alone installation or add features to an existing installation.
4. In the SQL Server 2016 Setup Window, allow it to check prerequisites. When this process is complete, click Next.
5. In the SQL Server 2016 Setup Window, at the Product Updates screen, click Next.
6. At the Install Setup Files screen, allow the wizard to install the files.
7. At the Setup Support rules screen, click Next.
8. At the Product Key screen, enter a valid product key, and click Next.
9. At the License Terms screen, accept the license terms, and click Next.
10. At the Setup Role screen, select SQL Server Feature Installation, and click Next.
11. At the Feature Selection screen, under Instances Features, select Database Engine Services with Full-Text and Semantic Extractions for Search and Data Quality Services, Reporting Services - Native, and SQL Client Connectivity SDK. Click Next.
12. Allow the Installation Rules check to run, and click Next.
13. At the Instance Configuration screen, select Default Instance and leave the default Instance ID.
14. At the Disk Space Requirements screen, click Next.
15. At the Server Configuration screen, set Startup Type for Server Agent, SQL Server Database Engine, and Server Browser as Automatic, and click Next.
16. At the Database Engine Configuration screen, select Mixed authentication mode, and add a password.
17. Click Add Current user.
18. Click Next three times.
19. Verify that the Summary is correct, and click Install.
20. Click finish when prompted.
22. Open Microsoft SQL Server Management Studio.
23. Sign into your SQL database.
24. Right-click your SQL host, and select Properties.
25. Select the memory page.
26. Change the minimum server memory to 8192.
27. Change maximum server memory to 16384. Click OK.
28. Click SQL Server Services in the tree.
29. Right-click SQL Server (Instance Name).
30. On the Log On tab, change the Account Name to test\administrator.
31. A popup will request to restart the service. Select Yes.

Installing the Certificate Authority
1. On the Certificate Authority Server, log in using the test.local\administrator account.
2. Launch Server Manager.
3. Click Add roles and features.
4. In the Add Roles and Features Wizard, click Next three times.
6. Click Next until you reach the confirmation screen.
7. Click Install. When complete, click Close.
8. In Server Manager, click the flag, and select the Post-deployment Configuration task.
9. In the AD CS Configuration Window, click Next.
10. Check the box for Certification Authority, and click Next.
11. Select Enterprise for the setup type, and click Next.
12. Choose Root CA for the CA type, and click Next.
13. Select Create a New Private Key, and click Next.
14. Accept all remaining defaults, and click Next through the remaining screens.
15. When prompted to begin configuration, click Configure.
16. To exit the wizard, click Close. Restart the server before continuing to the next steps.

Creating certificate templates for out-of-band management
1. Sign into ca.test.local using the domain\administrator account.
2. Open the Certification Authority.
3. Right-click the test-CA-CA, and click Properties.
5. On the Details tab, scroll to and select Thumbprint. Copy the 40-character code displayed in the details. You will add this information to the AMT BIOS later.
6. Click Ok to close the Certificate Authority properties.

Create the AMT provisioning certificate
1. Expand the Certification Authority, and select Certificate Templates.
2. Right-click Certificate Templates, and select Manage.
3. Locate Web Server in the list of available certificate templates. Right-click the template, and select Duplicate Template.
5. In the General tab, change the template name to AMT Provisioning.
7. On the Subject Name tab, select Build from this Active Directory Information. Select Common Name, and choose the option UPN.
8. On the Request Handling tab, check the box for Allow private key to be exported.
10. On the Extensions tab, select Application Policies, and click Edit.
11. Click Add. Click New. Type AMT Provisioning for the name, and 2.16.840.1.113741.1.2.3 as the Object Identifier. Click OK.
12. Ensure AMT Provisioning and Server Authentication are listed, and click OK.
13. Click OK to close the template properties.

Create the AMT Web Server Certificate
1. Right-click the web server template, and select Duplicate Template.
2. Select Windows 2003AMT.
3. On the General tab, change the template name to AMT Web Server Certificate.
4. On the General tab, choose the option Publish Certificate in Active Directory.
5. On the Subject Name tab, select Build from this Active Directory Information. Select Common Name, and choose the option UPN.
6. On the Security tab, ensure Domain Admins and Enterprise Admins have Enroll permissions.
7. Click OK to close the template properties.

Issue the certificate templates to Issue
1. In Certification Authority, expand test-CA-CA.
2. Right-click the Certificate Templates and select New→Certificate Template to Issue. If it is not available, restart the virtual machine.
3. Select the AMT Provisioning Template.
4. Click OK.
5. Repeat steps 2-4 for the AMT Web Server Certificate Template.

Request the certificates on the Configuration Manager server
1. Log into the Configuration Manager server as domain\administrator.
2. Click Start→Run. Type mmc, and press Enter.
3. In the mmc console, click File→Add/Remove Snap-in…
4. Select Certificates, and click Add. Select Computer account. Click Next.
5. Select Local computer, and click Finish.
6. Click OK.
7. Expand Certificates→Personal.
8. In the right panel, click More Actions→All Tasks→Request a new certificate…
9. Click Next.
10. Accept the defaults, and click Next.
11. Select the AMT Provisioning and AMT Web Server Certificate. Click Enroll.

Installing required Windows features and roles for System Center Configuration Manager
1. Sign into cm.test.local using the domain\administrator account.
2. Download the Windows Assessment and Deployment Kit for Windows 10 from the following Web site: https://go.microsoft.com/fwlink/?linkid=859206
3. Run adksetup.exe.
4. Select Install the Assessment and Deployment Kit to this computer, and choose an installation path. Click Next.
5. Select Deployment tools, Windows Pre-installation Environment features, and User State Migration Tool. Click Install.
6. When the install finishes, click Close.
7. Run the following commands in Windows PowerShell with administrator privileges:
   - Get-Module servermanager
   - Install-WindowsFeature Web-Windows-Auth
   - Install-WindowsFeature Web-ISAPI-Ext
   - Install-WindowsFeature Web-Metabase
   - Install-WindowsFeature Web-DAV-Publishing
   - Install-WindowsFeature BITS
   - Install-WindowsFeature RDC
   - Install-WindowsFeature NET-Framework-Features -source \yournetwork\yourshare\axs
   - Install-WindowsFeature Web-Asp-Net
   - Install-WindowsFeature Web-Asp-Net45
   - Install-WindowsFeature NET-HTTP-Activation
   - Install-WindowsFeature NET-Non-HTTP-Activ
8. Run Windows Update, and install updates.
9. Restart the server.

Installing System Center Configuration Manager 1702
1. Sign into cm.domain using the domain\administrator account.
2. Attach the SCCM 1702 Installation media to the management server.
3. Open splash.hta.
4. Click Install.
5. Read the Before You Begin section, click Next.
6. Choose Install a primary site. Choose use typical options.
7. Enter the product key.
8. Check the box to accept the License Terms, and click Next.
9. Accept the license agreements, and click Next.
10. Enter a path for the prerequisite file downloads. We used C:\Downloads
11. Select a language, and click Next for both server and client.
12. Enter a site code for the primary site. We used PTT.
13. Enter a Site Name. We used PT Test.
14. Click Next twice.
15. On the Settings Summary Screen, click Next.
16. Ensure that the console will be installed, and click Next.
17. Install as a primary stand-alone site.
18. Enter the SQL server name, and click Next.
19. Leave the default Database information, and click Next.
20. Accept the default SMS provider, and click Next.
21. Select the option to Configure the communication method on each site system role.
22. Select Clients will use HTTPS when they have a valid PKI certificate and HTTPS-enabled site roles are available, and click Next.
23. Select HTTP for Management Point and Distribution point, and click Next.
24. Select I don’t want to join the program at this time, and click Next.
25. Click Next.
26. Run the prerequisites check, and resolve any issues displayed.
27. Click Begin Install, and click Close when the installation is complete.
28. Download and install the installation for System Center R2 SP1 Configuration Manager from the following website: support.microsoft.com/kb/2922875/en-us
29. Download and install the cumulative update.

Configuring SCCM for Intel AMT testing
This is not required for testing Dell Client Command Suite and is completed only for the Intel AMT use cases.
1. In the SCCM console, under Administration→Site Configuration, click Server and Site System Roles.
2. Right-click cm.test.local, and select Add Site System Roles.
3. In the Add Site System Roles Wizard, click Next twice.
4. Select the Fallback status point, and click Next.
5. Click Summary.
6. Click Next.

Installing Intel Setup and Configuration Software (SCS) 11.1
2. Extract the contents to C:\IntelSCS_11.2.
3. Browse to C:\IntelSCS_11.2\IntelSCS\RCS.
4. Run IntelSCSInstaller.exe.
5. At the Welcome screen, click Next.
6. Select I accept the terms of the license agreement, and click Next.
7. Check the Boxes for Remote Configuration Service (RCS), Database Mode, and Console.
8. Enter the credentials of the Domain account that will run the service. We used test.local\administrator. Click Next.
9. Select cm.test.local as the location for the SCS database. This information may populate automatically. Select Windows Authentication, and click Next.
10. On the Create Intel SCS Database pop-up, click Create Database.
11. On the confirmation screen, click Close.
12. On the confirmation screen, leave the default Installation Folder, and click Install.
13. Once the installation is complete, click Next.
14. Click Finish.

Installing the provisioning certificate
1. Open MMC, and add the certificates snap-in, targeted at the local computer.
2. Navigate to Personal, Certificates.
3. Right-click the AMT Provisioning Certificate, and choose Open.
4. On the Details tab, click Copy to file.
5. On the Welcome screen, click Next.
6. On the Export Private Key screen, choose Yes, export the private key, and choose Next.
7. On the Export File Format screen, check the boxes for Include all certificates in the certification path if possible and Export all extended properties. Click Next.
8. On the Password screen, enter a password to protect the private key.
9. On the File to Export screen, enter C:\Install_Files\scs-prov-cert.pfx, and click Next.
10. On the Completed screen, click Close.
11. From an elevated command prompt, run the following commands:
   \SCS_download_package_11.2.0.35\utils\RCSutils.exe
   /Certificate Add c:\Install_Files\scs-prov-cert.pfx Password1
   net stop rcsserver
   net start rcsserver
12. To verify, run the following command, and make sure the expected certificate is listed:
   RCSUtils.exe /certificate view /RCSuser NetworkService /log file C:\rcsout.txt

Creating the AMT configuration profile
1. On the management server, launch the Intel Setup and Configuration Console.
2. Click Profiles.
3. To construct a profile for deployment, click New.
4. For Profile Name, enter a description of the target clients. We used wireless. Click OK.
5. On the Getting Started Screen, choose Configuration / Reconfiguration.
6. On the Optional Settings screen, choose the options Active Directory Integration, Access Control List (ACL), and Transport Layer Security (TLS), Network Configuration, Wired 802.1x and click Next.
7. On the AD Integration screen, browse for the OU created for the AMT managed devices. We used OU=AMT, DC=test, DC=local. Click Next.
10. Add Kerberos Admin, Domain Admins, or other administrative users groups. Click OK.
11. For Access Type, select Remote.
12. Choose the option for PT Administration. Click OK.
13. Click Next.
14. On the TLS screen, from the drop-down menu, select the Enterprise Certificate Authority, ca.test.local.
15. Select the Server Certificate Template to be used to generate certificates for the AMT devices. We selected AMTWebServerCertificate. Click Next.
16. On the Network Configuration Screen, select Allow Wired connection with the following WiFi setups.
17. Click Add…
18. On the 802.1x Setup screen, click Edit list.
19. Click Add, then use the test-CA certificate authority. Click OK.
20. Click OK.
22. Select Use the following password for all systems. Enter the password for use after provisioning is complete. We used P@ssw0rd
23. Enter the RFB Password for KVM sessions. We used P@ssw0rd
24. Enter the MEBX password. We used P@ssw0rd
25. Click KVM Settings…, uncheck User Consent required before beginning KVM session, and click OK.
26. Check the boxes for the following options:
   a. Synchronize Intel AMT clock with operating system
   b. Enable Intel AMT to respond to ping requests
   c. Enable Fast Call for Help (within the enterprise network)
27. To Edit IP and FQDN settings, click Set.
28. In the Network Settings window, select Use the following as the FQDN, and choose Primary DNS FQDN from the drop-down menu.
29. Choose the option that indicates the device and the OS will have the same FQDN (Shared FQDN).
30. Select Get the IP from the DHCP server.
31. Select Update the DNS directly or via DHCP option 81. Click OK.
32. Click Next.
33. Click Finish.
Adding the configurator to a shared folder
1. Create a shared folder called `amtshare`
2. Copy the file at `C:\IntelSCS_11.3\IntelSCS\Configurator` to the shared `C:\amtshare` folder.

Installing certificates on target systems
Configuration for our laptop varied from this since we used a self-signed certificate. In order to configure the system, we first manually input our configuration information into the pre-boot MEbx menu. This work around will not be necessary for users who purchase their certificates.
1. On each target system, during boot, press Ctrl + P to enter the Intel Management Engine BIOS Extension.
2. Enter the Intel ME Password. The default is `admin`. We changed ours to `P@ssw0rd`
4. Press the insert key to add a certificate hash.
5. Enter a name for the hash.
6. Enter the 40-character thumbprint recorded before.
7. Exit the MEbx menu.

Testing methodology
Before each test, ensure all target desktops are powered on and are signed out of the user account. Ensure that all systems are domain joined and that they have the configuration manager client installed prior to running the provisioning command. Ensure all systems are connected to a monitor.

Dell desktop with Command Suite
At the beginning of all tests, the administrator is logged into the management server at the desktop. Tests in this section require additional time for the commands to complete during which the administrator is not actively inputting commands. We refer to this as system time. We have recorded both admin time and system time in Appendix C.

Configuring AMT
Prior to this test, ensure all target clients have been added to the target collection.
1. On the Configuration Manager server, open the configuration manager console.
2. Open the Assets and Compliance panel.
3. Open Device Collections.
4. Right-click the collection that you wish to deploy to, and select Deploy → Task Sequence.
5. In the Deploy Software Wizard, next to Task Sequence, click Browse.
6. Select the vPro-AMT Configure Client task sequence, and click OK.
7. In the Deploy Software Wizard, click Next.
8. Next to Purpose, select Required, and click Next.
9. Select a time when the deployment will become available, and click Next.
10. On the user experience screen, click Next.
11. On the Alerts screen, click Next.

For timing purposes, we used RDP to connect to the target system and ran a Machine Policy Retrieval & Evaluation Cycle using the Configuration Manager Properties menu in Control Panel to trigger the install.

For the two-system test, we completed steps 1 through 13 once, but added the additional client to the collection prior to running the test.

Changing one BIOS setting
1. Open the Dell Intel vPro Out of Band plugin.
2. Under Client Configuration, select BIOS Settings.
3. On Active Processor Cores, select All, and check the Apply checkbox. Click Next.
4. Add the target system and click Next.
5. Add a description, and click Next. We typed test.
6. Click Finish.

For the two-system test, we completed steps 1 through 6 once, but selected all systems in step 4.
Changing 10 BIOS settings
1. Open the Dell Intel vPro Out of Band plugin.
2. Under Client Configuration, select BIOS Settings.
3. For Auto On, check the box, and select Every day.
4. For Active Processor Cores, check the box, and select All.
5. For Enable Audio, check the box, and select Enabled
6. For SATA-0, check the box, and select Enabled.
7. For Trusted Execution, check the box, and select Enabled.
8. For Intel TurboBoost, check the box, and select Enabled.
9. For Front USB Ports, check the box, and select Enabled.
10. For USB Rear Port 1, check the box, and select Enabled.
11. For VT for Direct IO, check the box, and select Enabled.
12. For Wake on LAN, check the box, and select LAN or WLAN. Click Next.
13. Select the clients to add.
14. Click Next.
15. Add a description.
16. Click Finish

For the two-system test, we completed steps 1 through 16 once, but selected all systems in step 13.

Changing the Boot Order
1. Open the Dell Intel vPro Out of Band plugin.
2. Under Client Configuration, select Boot Order.
3. Select only Internal HDD (IRRT) boot and click Next.
4. Add the target system and click Next.
5. Add a description and click Next. We typed test.
6. Click Finish.

For the two-system test, we completed steps 1 through 6 once, but selected all systems in step 4.

Setting a system password on the target system
1. Open the Dell Intel vPro Out of Band plugin.
2. Under Client Configuration, select Passwords.
3. Select Set, and select Administrator.
4. Enter and confirm a BIOS Password, and click Next. We used Password1.
5. Add the target system, and click Next.
6. Add a description, and click Next. We typed test.
7. Click Finish.

For the two-system test, we completed steps 1 through 7 once, but selected all systems in step 5.

Wiping the Client Data on the target system
1. Open the Dell Intel vPro Out of Band plugin.
2. Under Operations, select Wipe Client Disk.
3. Add the target system and click Next.
4. Add a description and click Next. We typed test.
5. Click Finish.

We do not include time or steps for this task, but did complete it to verify functionality.

Enabling Intel vPro without the Dell Command Integration Suite

We completed this test for the Dell desktops and recorded it as a manual task.
1. Log into the target system over RDP using test\administrator.
2. Navigate to the shared folder on the configuration server, and copy the Configurator folder onto the desktop.
3. Open the target folder.
4. Click File, navigate to Open command prompt, then click Open command prompt as Administrator.
5. Run the following command in the elevated command prompt:
   ACUConfig.exe /Verbose /Output console ConfigViaRCSOnly cm.test.local test
After starting the previous command, stop the admin time timer, and start the system time timer. Stop the system time timer and once the command stops running and exits with code 0, indicating a successfully provisioned system.

For the two-system test, repeat steps 1-5 for the second system. Immediately start repeating the above steps on the second system and do not start the system time timer till you complete the steps for the second system.

**Conducting the Intel vPro and manual tests**

We used the steps in the sections below for both vPro and Manual tests. vPro tests use vPro's KVM feature to complete the task. Manual tasks are completed at the target desktop's console.

For all vPro tests, we use Intel Manageability KVM to complete the task.

1. Open the Intel Manageability Connector.
2. Connect to the target system.
3. Click Remote Desktop.

We added these steps to the total steps for all vPro tasks. Additionally, all two-system tests repeat steps 2 through 3 for the second system.

**Changing one BIOS setting**

For vPro tests, use Intel Manageability Commander to connect to the target system. For non-vPro tests, complete the actions when connected via the Intel Manageability Commander.

1. Reboot the target client to System Setup.
2. Under Performance, select Multi Core Support.
3. For Multi Core Support, select All.
4. Click Exit and click Yes when prompted to save changes.

For the two-system test, repeat steps 1 through 4 on the second system.

**Change 10 BIOS settings**

For Intel vPro tests, use Intel Manageability Commander to connect to the target system. For non-vPro tests, complete the actions when connected via the Intel Manageability Commander.

1. Reboot the target client to System Setup.
2. Under System Configuration, select Drives.
3. For SATA-0, check the box for SATA-0.
4. Under System Configuration, select USB Configuration.
5. Check the box for Enable Front USB Ports.
6. Under System Configuration, select Front USB Configuration.
7. Check the box for Front Port 1 w/ Power Share(Bottom)*.
8. Under Onboard Audio Controller, click Audio.
9. Check the box for the Enable Audio option.
10. Under Performance, select Multi Core Support.
11. For Multi Core Support, select All.
12. Select Intel TurboBoost.
13. Check the Box for Enable Intel Turboboost.
15. Check the box for Enable Intel Virtualization Technology.
16. For Direct I/O, Select VT.
17. For Direct I/O, Check the box for Enable VT.
18. Select Trusted Execution.
19. Check the box for Trusted Execution.
20. Under Power Management, select Wake on LAN/WLAN.
21. For Wake on LAN/WLAN, select LAN or WLAN.
22. Click Exit and click Yes when prompted to save changes.

For the two-system test, repeat steps 1-22 on the second system.
Changing the Boot order
For Intel vPro tests, use Intel Manageability Commander to connect to the target system. For non-vPro tests, complete the actions when connected via the Intel Manageability Commander.

1. Reboot the target client to System Setup.
2. Under General, select Boot sequence.
3. Select the Onboard NIC and uncheck the box.
4. Click Exit and agree to save changes.
For the two-system test, repeat steps 1 through 4 on the second system.

Change the system password
For Intel vPro tests, use Intel Manageability Commander to connect to the target system. For non-vPro tests, completed the following actions at the console.

1. Reboot the target client to System Setup.
2. In the Dell OptiPlex 7050 setup menu, under security, select Admin Password.
3. Enter and confirm and the new Password. We used Password1.
4. Click Exit and click save when prompted.
For the two-system test, repeat steps 1 through 4 on the second system.
Appendix C: Our results

The tables below show the admin time required to manage one, two, and 100 systems. To estimate the time to perform tasks on 100 systems, we used the formula \( W + (98 \times \Delta t) \), where \( W \) is the time to perform a task on two systems, and \( \Delta t \) is the time difference between the one- and two-system tests.

### Admin time to complete management tasks (mm:ss)

<table>
<thead>
<tr>
<th>Task</th>
<th>Command Suite</th>
<th>AMT only</th>
<th>Manual</th>
<th>Command Suite</th>
<th>AMT only</th>
<th>Manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provisioning AMT</td>
<td>00:48</td>
<td>N/A</td>
<td>00:51</td>
<td>00:48</td>
<td>N/A</td>
<td>01:43</td>
</tr>
<tr>
<td>Changing the boot order</td>
<td>00:21</td>
<td>00:43</td>
<td>00:43</td>
<td>00:21</td>
<td>01:27</td>
<td>01:26</td>
</tr>
<tr>
<td>Changing a BIOS setting</td>
<td>00:25</td>
<td>00:51</td>
<td>00:50</td>
<td>00:25</td>
<td>01:40</td>
<td>01:40</td>
</tr>
<tr>
<td>Changing 10 BIOS settings</td>
<td>01:35</td>
<td>01:45</td>
<td>01:48</td>
<td>01:35</td>
<td>03:25</td>
<td>03:32</td>
</tr>
<tr>
<td>Changing the system password</td>
<td>00:28</td>
<td>00:45</td>
<td>00:42</td>
<td>00:28</td>
<td>01:28</td>
<td>01:24</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task</th>
<th>Command Suite</th>
<th>AMT only</th>
<th>Manual</th>
<th>Time saved</th>
<th>Percent savings</th>
<th>Command Suite</th>
<th>AMT only</th>
<th>Time saved</th>
<th>Percent savings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provisioning AMT</td>
<td>00:00:48</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>01:26:39</td>
<td>01:25:51</td>
<td>99.1%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Changing the boot order</td>
<td>00:00:21</td>
<td>01:13:19</td>
<td>01:12:58</td>
<td>99.5%</td>
<td>01:11:40</td>
<td>01:11:19</td>
<td>99.5%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Changing a BIOS setting</td>
<td>00:00:25</td>
<td>01:21:42</td>
<td>01:21:17</td>
<td>99.5%</td>
<td>01:23:20</td>
<td>01:22:55</td>
<td>99.5%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Changing 10 BIOS settings</td>
<td>00:01:35</td>
<td>02:46:45</td>
<td>02:45:10</td>
<td>99.1%</td>
<td>02:53:24</td>
<td>02:51:49</td>
<td>99.1%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Changing the system password</td>
<td>00:00:28</td>
<td>01:11:42</td>
<td>01:11:14</td>
<td>99.3%</td>
<td>01:10:00</td>
<td>01:09:32</td>
<td>99.3%</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The tables below show the admin steps required to manage one, two, and 100 systems.

### Admin steps to complete management task

<table>
<thead>
<tr>
<th>Task</th>
<th>Command Suite</th>
<th>AMT only</th>
<th>Manual</th>
<th>DCCS</th>
<th>AMT only</th>
<th>Manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provisioning AMT</td>
<td>13</td>
<td>N/A</td>
<td>5</td>
<td>13</td>
<td>N/A</td>
<td>10</td>
</tr>
<tr>
<td>Changing the boot order</td>
<td>6</td>
<td>7</td>
<td>4</td>
<td>6</td>
<td>13</td>
<td>8</td>
</tr>
<tr>
<td>Changing a BIOS setting</td>
<td>6</td>
<td>7</td>
<td>4</td>
<td>6</td>
<td>13</td>
<td>8</td>
</tr>
<tr>
<td>Changing 10 BIOS settings</td>
<td>16</td>
<td>25</td>
<td>22</td>
<td>16</td>
<td>49</td>
<td>44</td>
</tr>
<tr>
<td>Changing the system password</td>
<td>7</td>
<td>7</td>
<td>4</td>
<td>7</td>
<td>13</td>
<td>8</td>
</tr>
</tbody>
</table>

### Admin steps - 100-system extrapolation

<table>
<thead>
<tr>
<th>Task</th>
<th>Command Suite</th>
<th>AMT only</th>
<th>Steps saved</th>
<th>Percent savings</th>
<th>Command Suite</th>
<th>AMT only</th>
<th>Steps saved</th>
<th>Percent savings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provisioning AMT</td>
<td>13</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>500</td>
<td>487</td>
<td>97.4%</td>
<td></td>
</tr>
<tr>
<td>Changing the boot order</td>
<td>6</td>
<td>601</td>
<td>595</td>
<td>99.0%</td>
<td>400</td>
<td>394</td>
<td>98.5%</td>
<td></td>
</tr>
<tr>
<td>Changing a BIOS setting</td>
<td>6</td>
<td>601</td>
<td>595</td>
<td>99.0%</td>
<td>400</td>
<td>394</td>
<td>98.5%</td>
<td></td>
</tr>
<tr>
<td>Changing 10 BIOS settings</td>
<td>16</td>
<td>2,401</td>
<td>2,385</td>
<td>99.3%</td>
<td>2200</td>
<td>2,184</td>
<td>99.2%</td>
<td></td>
</tr>
<tr>
<td>Changing the system password</td>
<td>7</td>
<td>601</td>
<td>594</td>
<td>98.8%</td>
<td>400</td>
<td>393</td>
<td>98.2%</td>
<td></td>
</tr>
</tbody>
</table>
This project was commissioned by Dell Technologies.

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

DISCLAIMER OF WARRANTIES; LIMITATION OF LIABILITY:
Principled Technologies, Inc. has made reasonable efforts to ensure the accuracy and validity of its testing, however, Principled Technologies, Inc. specifically disclaims any warranty, expressed or implied, relating to the test results and analysis, their accuracy, completeness or quality, including any implied warranty of fitness for any particular purpose. All persons or entities relying on the results of any testing do so at their own risk, and agree that Principled Technologies, Inc., its employees and its subcontractors shall have no liability whatsoever from any claim of loss or damage on account of any alleged error or defect in any testing procedure or result.

In no event shall Principled Technologies, Inc. be liable for indirect, special, incidental, or consequential damages in connection with its testing, even if advised of the possibility of such damages. In no event shall Principled Technologies, Inc.’s liability, including for direct damages, exceed the amounts paid in connection with Principled Technologies, Inc.’s testing. Customer’s sole and exclusive remedies are as set forth herein.